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Introduction

Photoshop is an extremely power tool for editing and manipulating im-
ages.  And with great power comes great responsibility. Simply because 
we can do something, doesn’t mean we should.

There is tremendous power in the truth of a photograph. Even if 
you’re not working in journalism, consider this before altering the   
content of a photograph.

There are many stories of journalists losing their jobs and ending their 
careers because they abused the power of Photoshop

This tutorial is designed to introduce you to a very complicated pro-
gram and teach you some basic skills for adjusting a photograph.

It is NOT designed to detail every single feature of the program.
IT is specifically written for Photoshop CC 2020 v. 21.1.3 and is cur-
rent as of May 2020 (** Some of the embedded videos were created 
using older versions of Photoshop but are still accurate)

This tutorial will look at these key features of Photoshop

 1.  Viewing photos

 2.  Adjust tone/color/contrast/captions

 3.  Cropping/Resizing

 5.  Working with Raw files

•
NOTE:  This tutorial was 
written for the Mac OS. 
But the program should 
look very similar on a 
Windows computer.

There is a tablet version 
of Photoshop as well - it 
offers fewer features than 

the desktop version.
•

Links to all the video 
tutorials can be found 

here:
VIDEOS

https://www.willyurman.com/teaching/handouts-2/photoshop-video-tutorials/
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•
If you want to learn 
more about Photoshop 
one great resource is 
Linkedinlearning.com.
The site offers tutorials 
on a wide range of ap-
plications and is free to 
Penn State students.

•

If you don’t like 
the layout of the              
Photoshop display, you 
can rearrange panels 
and create a cus-
tom workspace.  Go 
Window>Workspace

•

Tools and Workspace

Photoshop is part of the Adobe Creative Suite of applications. This 
means the look and interface will feel familiar as you move from app 
to app, from Photoshop to Premiere to Audition to Indesign, etc. 

Open the application.  To open an image:
 You can use File>Open..., you can use the quick keys ⌘ O, or 
you can drag an image file onto the application’s icon.

Once you open an image you should see something like this:

There is a lot going and a lot of information. For now, the key points:

1. The image itself is displayed in the center. You can zoom in and 
zoom out using the tools or View> Zoom in or Zoom out

https://linkedinlearning.psu.edu/
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2. The tool bar.  In Photoshop you select a tool to complete different 
tasks. We’ll talk about some of the tools in depth during this tutorial, 
but not all of them. 

3. Notice the settings at the top. They will change depending on what 
tool is selected - allowing you change the size of the tool for example 
or its intensity.

4. Panels – Photoshop has a host of panels that give access to        
different functions. You can find them under  the Window drop down 
tab.  Again, we’ll talk about a few of them during this tutorial. 

•
Rollover a tool to 
see it’s name and 
keyboard shortcut. 
Learning the short-
cuts will let you work 
faster.

•

The Tool Bar

Select different tools to adjust your photos in different ways.  You 
might want to select part of the image – someone’s face for example. 
We have different tools that will allow you to do that.

There is a cropping tool for cropping your image.

A tool for removing imperfections – dust on your camera’s sensor can 
create blemishes in your photo.

Tools that will allow you darken or lighten an area of your photo.

You can add text to an image – if you’re creating an ad or poster for 
example.
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marquee tool (M) - move area of an image
 
lasso tool (L) - select an area by drawing a shape around it
quick selection (W) - selects an area of similar tone 
crop tool (C) - click and drag a box to crop the image

eye dropper (i) - use with info panel to measure image
red eye/healing brush (J) - use with care to remove sensor  
 dust or the red eye from a direct flash
clone tool (S) - use with care to remove sensor dust
history brush (Y) - use with history panel as a toning tool. 

burn/dodge tool (O) - lighten and darken selective areas 

type tool (T) - apply type over an image. 

zoom tool (Z) zoom in for a closer look.

Some of the key tools and their keyboard shortcuts.

•
Not to beat a dead 
horse, but learning 
the keyboard short-
cuts for a program 
will let you work 
more quickly.
Rollover a tool and 
the name and short-
cut are revealed. For 
example:
C – Crop
Y – History Brush
T – Type Tool

•
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Tools in depth

•
Note that many tools 
have ‘sub-tools’.
Click and hold the 
small rectangle to see 
other options within 
a specific tool.

•
With all the selection 
tools, if you want to 
add to a selection or 
select an additional 
area, hold down the 

Shift key.
Hold down the Op-
tion key to deselect 
part of a selection

•

 The Lasso Tool (L)  Click and draw to select an area of the 
photo. You could outline a person’s face, or the sky for ex-
ample. This would allow you to adjust just the selected area - 
make it darker, adjust the color, etc.

Watch a 2:10 video on using the Lasso tool

The Quick Selection Tool (W) offers three                                                                      
other ways of selecting an area of the image. 
To use the Quick selection tool click and drag 

over an area of the photo that has a consistent tone.  You can 
quickly select the sky for example, or the grass.
The Magic Wand tool is similar. But you can just click on part 
of the image and the wand will expand to select similar areas.
The newest and easiest way to select is with the Object Se-
lection Tool. Simply select around an area and Photoshop will 
work it’s magic to select the specific object. Pretty amazing.

Watch a 5:19 video on using the Quick Selection/Magic 
Wand/Object Selection tools

The Crop Tool (C)  Crop your photo to improve the 
composition or to fit it to a specific shape. If you are using a 
photo in a video for example, you would probably crop it to 
fit the 16:9 perspective of a video which is skinnier than an 
uncropped still image. You can crop to a specific dimension or 
crop using your eye for what looks best.

Watch a 2:12 video on using the Crop tool

https://vimeo.com/176869800
https://vimeo.com/176883209
https://vimeo.com/176883209
https://vimeo.com/176884482
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The Eyedropper Tool (I) can be used to give you detailed 
information about the density or color of your image. Use it 
in conjunction with the Info Panel.

Watch a 3:24 video on using the Info Panel

The Spot Healing Brush Tool (J) A powerful tool that 
presents ethical concerns in journalism.  Brush over an area 
of a photo and Photoshop will try to ‘heal’ or fix what is 
brushed. This usually means eliminating it and trying to fill 
in the background.  If you have dust on the camera sensor 
and it shows up as a small mark on the file, you could ethi-
cally use the tool to remove that blemish. But for journalists, 
changing the reality of the photo is forbidden. If you are a 
commercial photographer, you could use the tool to remove 
distractions.

Watch a 5:33 video on using the Spot Healing Brush and 
Clone Stamp tool tool

The Brush Tool (B) and its related sub-tools allows you 
to draw on your photo.

The Clone Stamp Tool (S) is similar to the Healing 
Brush Tool and presents the same ethical issues to jour-
nalists. It allows you to copy from one area of a photo to 
the other. Hold down the option key to select the area to 
copy. Then click and drag to copy that information some-
where else, ‘cloning it’.

See video for Spot Healing Brush above

•
When using the 
eyedropper tool, one 
number to measure 
is the image density 
for skin – We want 
people to look good 
in photos.
A rough rule, for 
caucasians, skin tone 
should be about 35-
40% in the light (not 
in shadow)
African-American 
skin values can go as 
high as 70%

•

https://vimeo.com/176941103
https://vimeo.com/176947251
https://vimeo.com/176947251


Photoshop

      Tips & Tricks

updated May 2020

9

The History Brush Tool (Y) is a tool I use a lot when    
toning or adjusting an image. Use it in conjunction with the 
History panel.  You can use the brush to paint in the previous 
state of an image in a selected area.
For example, you’ve lightened the entire image but you really 
want the sky to look as it did in the original photo – select the 
original state in the History panel and then use the History 
Brush to ‘paint’ in that original darkness of the sky.

Watch a 4:32 video on using the History tool

The Burn & Dodge Tools(O) are useful for quickly and 
easily darkening or lightening an area of a photo. The Burn 
Tool will darken an area. You can adjust the intensity and 
size of the brush at the top of the screen.  The Dodge Tool 
is used in the same way but lightens an area.  Once you 
select the brush size and intensity click and drag to paint 
over an area. Use the History panel to undo if necessary.

Watch a 2:23 video on using the Burn/Dodge tool

The Type Tool (T) can apply type to a photo. Once se-
lected you’ll have options for fonts and sizes.

Watch a 4:55 video on using the Type Tool

•
If you want blank 
space around a 
photo, to add type 
to for example, you 
can extend the size 
of the canvas – the 
area around the 
photo.

Go Image>Canvas 
Size. 
You can select 
whether the image 
remains centered 
on the canvas or 
not.

•

The Zoom Tool (Z) allows you to zoom in on an image - 
this can make it easier to see if the photo is sharp and allows 
for more precise control of an area of the photo. Click to 
zoom in. Old the option key to zoom out.

Watch a :55 video on using the Zoom Tool

These are the tools we are most likely to use in this tutorial. You can explore the 
other tools and features of Photoshop on your own

https://vimeo.com/177012488
https://vimeo.com/177084549
https://vimeo.com/177090662
https://vimeo.com/177097927
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Toning
We will define toning as making basic adjustments to color, brightness, 
contrast and cropping.  These are basic changes to the image that aim 
to bring it more in line with what we actually saw and to make the 
photo suitable for publication in either print or a digital environment.

The tutorial will not cover retouching – the removal or changing 
of content in the photo. You can certainly learn those skills in other 
classes or by using online resources such as Linkedinlearning.com

Photoshop is an extremely powerful program and there are many 
ways to get to the same place. If you have used the program before 
you may have learned other ways of adjusting an image.  I don’t think 
there is a single best way – I will cover one method that I find works 
well for most situations.

My goal with this tutorial is to give you a basic set of skills that will   
allow you to make simple adjustments to your images quickly and 
easily.

Less time using Photoshop equals more time for other things.

Toning a photo in Photoshop 
in 10 (ish) steps

Properly exposed and photographed images should NOT require 
extensive toning.

Photoshop is NOT the fix-it tool for lazy and bad photography.

•
Remember that 
changes you make 
in Photoshop are     
permanent. If you 
make a mistake you 
may not be able to 
undo it later on.

Always work on a 
copy of your original.  
When you are se-
lecting images, make 
a copy of your best 
photos and work on 
the copy.

While it is possible to 
save your adjustments 
as separate layers in a 
photo, that workflow 
is beyond the scope 
of this tutorial.

Working on a copy is 
always a smart idea.

•

https://linkedinlearning.psu.edu/
https://linkedinlearning.psu.edu/
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If you get it right in the field, it should take less than 10 minutes to 
tone a photograph. 

ALWAYS WORK ON A COPY – NEVER YOUR ORIGINAL FILE!!

1.   Analyze
Open your photo in Photoshop and take a moment to consider   
contrast, tonal qualities, and sharpness. Check tonal values for key    
areas such as skin tones using the eyedropper and info palette.

In the info palette set second ‘eyedropper’ to grayscale 
Read the skin tone with the eyedropper - avoid highlights or shadows 
when looking for skin values ~36% K Value for front lit Caucasian skin 
and up to 70% for African American skin tones.

The eyedropper was placed on his forehead, an area of his skin that 
was not in shadow or too bright from the reflection of light. Note 
the K value is 36% – where you want to be for typical caucasian skin 
values.  Notice on the left the RGB values - these measure the color. 
Blue has the lowest value and the opposite of blue is yellow - in gen-
eral skin has a yellowish cast to it.

•
When you select the 
eyedropper tool, set 
the ‘sample size’ at 
the top left to ‘3 by 
3’. This way the eye 
dropper will aver-
age a small group 
of    pixels and not 
be fooled by a single 
aberrant one.

•
It is worth        

knowing your colors. 
Understand the color 

wheel.

If you subtract one 
color, you add its 
opposite. Remove     
yellow and you get 
blue for example.
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2. Rotate and Crop
Decide how to best crop the photo. There is no reason to spend time 
toning part of a photo if you’re going to crop it.  You can crop to a   
specific dimension or leave it open to what you think looks best.

Try to avoid cropping to odd sizes and shapes. But certainly crop to 
eliminate distractions and improve composition.

Click on the Crop tool and then resize the box. Double click in the 
middle of the image when you’re done.
Watch a 1:51 minute video on cropping.
3. Basic Tonal Adjustment Use 
We’ll use Levels (⌘L) to adjust Black and White points. The goal is to 
adjust the brightness and the range of tones within the image. You want 
bright/white tones to look white and dark/black tones to look black 
while still keeping a full range of tones. If your image looks grey and 
muddy and flat, it will feel dull. If all we see are stark black and white 
tones, the image will lack detail and richness.

Drag the black and white points to the base of the curve

It may be hard to see, but by dragging the end points you are extending 
the range of tone of the image. You are resetting the range. 

Before: Black and white points ex-
tend beyond the ‘mountain’ of data. 
The image is flatter and duller.

After: Black and white points 
are dragged into the ‘base of the   
mountain’, creating a richer tone

https://vimeo.com/176884482


Photoshop

      Tips & Tricks

updated May 2020

13

Be careful, if you slide into the ‘mountain’ you will start to lose informa-
tion. Sometimes that won’t be a problem - the information isn’t im-
portant.

But if you’re not careful you’ll lose detail in highlights and/or shadow 
areas.

Watch a 4:51 minute video on setting tonal range using Levels.

4. Color Cast
Sometimes the camera won’t capture the color accurately.

The photo may be too yellow or blue or green or whatever.  This hap-
pens most commonly in unusual lighting situations – a mix of kinds of 
light or unusual fluorescent lighting etc.  Our cameras, if set properly, 
do a very good job outdoors in natural light but sometimes struggle 
with artificial lighting. 

IF the color cast is extreme, we probably can’t do a very good of fixing 
the problem. So it is important to make sure you’re capturing your  
image with the proper settings. BUT if the color is off by a little bit 
there is a nice technique for fixing it.

The theory is simple. If we can make something in the photo that is 
supposed to be white/grey look white/grey then all the other colors 
will fall into place. If the whites are too yellow, everything is probably 
too yellow. 

By ‘setting’ a white we reset the baseline and hopefully everything falls 
into place. 
OF all the steps, this is the most complicated to follow. But once 

•
If you hold the      
option key down 
while  dragging either 
the black or white 
arrow, you’ll get a 
display that shows 
you where you’re los-
ing detail.  The screen 
will turn black and 
areas that have lost 
all their detail will be       
highlighted

•

•
I will talk about ‘ 
setting a white’, but 
make sure you use 
an area in the image 
that has detail. A pure 
white like the sun 
won’t work – it has 
no information. Light 
greys are the best.

•

https://vimeo.com/176876377
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•
If you set a white and 

don’t like the results, use 
the History Tab to undo, 
and start over. It usually 

means you either moved 
the mouse accidentally or 

hadn’t picked a neutral 
area to work on.

•

you’ve done it a few times it becomes pretty simple to master.

There are six steps to this technique:
1. Open Levels
2. Double click on the white eye dropper
3. Click on an light neutral area – light white to medium grey            
AFTER CLICKING DON’T MOVE THE MOUSE. LEAVE THE CURSOR 
WHERE YOU CLICKED
4. Use tab key to scroll through the color picker and set the A & B 
channels to zero
5. Click return to close the color picker
6. Click the mouse without moving it (if you’ve moved the mouse at any 
point, you need to start over). This should ‘set the white’

The levels are open, we’ve clicked on the man’s white shirt and are 
ready to zero out the A&B channels.
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Notice the mouse hasn’t moved.
THIS IS KEY
After clicking on his white shirt I use the keyboard
NOT THE MOUSE
To set the A&B channels to zero
Then click ‘return’ 
And FINALLY click the mouse on the same
spot of his shirt. And voila.

Watch a 3:15 video on removing color cast using Levels.

5. Midtones
To this point we’ve corrected the color and over tonal range. Some-
times we may need to adjust the midtones, those middle grays that 
may be too bright or too dark. Correcting the color will sometimes 
shift these so make sure to do this step after color correcting.

https://vimeo.com/176980695
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We use the midtone control, the gray middle arrow in Levels, to ‘open 
up the shadows’ and let in some detail while keeping the range of 

tones we set with the black and white points.

Watch a 1:22 video on adjusting the midtones of an image

6. Local Adjustments
To this point we’ve made global changes to the photo – all or      
nothing changes.  Now is the time to look and see if a specific area 
needs adjusting. We might lighten a face or darken the foreground or 
background of an image.  If you’re a journalist you want to take GREAT 
CARE in making these adjustments. It is easy to step beyond the     
ethical standards of photojournalism. 

In general, we don’t want to remove an element or change it 
so     dramatically that we’ve altered the reality of the scene.  A             
photojournalist should never eliminate a pole that is sticking out of 
someone’s head just because it is a distraction or add a cloud to a blue 
sky.  Neither should they so darken something that we can’t recognize 
that it was there.

Never make a change that would mislead or 
misrepresent what actually occurred. 

•
The National Press 
Photographers As-
sociation (NPPA) has 
a code of ethics that 
speaks to the manip-
ulation of images:
https://nppa.org/
code_of_ethics

•

https://vimeo.com/177007473
https://nppa.org/code_of_ethics
https://nppa.org/code_of_ethics
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For other kinds of photographers working in advertising or as an artist or 
wedding photographer for example, you will need to use your judgement and 

the judgement of your employer or client.

This tutorial will only cover very basic adjustments. Photoshop is a 
very powerful program. You can change the color, shape, perspective of       
elements. You can remove blemishes and alter the appearance of light. 
And on and on. Those skills are beyond the scope of this tutorial.

For the basic toning of an image we will talk about two things:
1. Lightening/darkening
2. Adjusting color

IF you want to adjust a part of a photograph, you need to select the 
area you want to adjust.  

The Lasso and Quick Selection tools explained earlier in the tutorial are 
easy ways to isolate someone’s face, or the sky or some other area of 
the photograph.

Once selected you can apply the same tools we’ve used to adjust the 
entire image. Levels can be used to lighten or darken or even alter the 
color of the selected area.

1. Select the area that needs ‘fixing’.
2. Feather the selection so that the edge is softened between the        
selection and the rest of the image.
3. Make the adjustment

The burn/dodge tool can also be useful for lightening or darkening a 
area of a photo.
The Burn Tool makes an area darker.  
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Here’s a photo of a protest from the Democratic National Convention 
in Philadelphia in July, 2016.  Overall, the color looks good and there is 
a wide range of tone.  But, I want to make sure the viewer is drawn to 
the protester’s expression. I wish her face were a little lighter.

If I lighten the whole photo, her face looks better but the rest of the 
photo looks washed out.  
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Here are three ways to lighten her face without lightening the rest of 
the image.

A. Select and Lighten
Use the Lasso or Quick Selection tools to select her face and arm.
Feather the selection and then use Levels to lighten the selection.

If you look closely you can see the outline of the selection of her arm 
and face. I then used Levels to lighten just those elements. The rest of 
the photo is the same as the original on the previous page.

B. Burn and Dodge
Use the Dodge tool to lighten her face and arm by painting over it. You 
can adjust the size and intensity of the tool.

I find a good starting point is to set the brush to ‘midtones’ and about 
30%. You can keep ‘painting’ to lighten more if you need to.
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Note that her skin looks little redder/warmer. You can get a shift of 
color when you use the dodge tool. 

Watch a 2:23 video on using the burn/dodge tool

C. History Brush
This method can seem a little more complicated but often gives the 
most natural results.

The history brush allows you to ‘paint’ in the previous state. So, you 
can lighten the entire image for example, and then revert part of the 
image back to where it started. 

To use the History brush you also need to open the History Win-
dow Pane. 

I find this method allows for the most natural adjustments in many 
cases. And with practice is very fast.

•
Sometimes colors 
shift when you lighten 
them, especially with 
the dodge tool.

The Hue/Saturation 
tool can bring those 
colors back into line. 
You want to make 
sure a person’s skin 
tone remains consis-
tent.

•

https://vimeo.com/177084549
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In this example I opened the image and 
then used Levels to lighten the entire 
photograph.

I click the check box next to the origi-
nal image, above the change I made in 
Levels.

Then, each time I use the History brush 
I am returning that area of the photo to 
the original state.

You are less likely to get a color shift this way and less likely to see the 
edge between an area you changed and the rest of the photograph.
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IF you’ve done a good job shooting your photo - set a proper expo-
sure and white balance – you should be done toning your photo at 
this point.

If it takes more than 5-10 minutes to adjust your photo, you’re prob-
ably trying to fix something that went wrong.  And you’ll probably find 
it’s is difficult or impossible to make it perfect.

It is VERY important that you don’t rely on Photoshop to fix mistakes 
in the field.  

You may sometimes need to use other tools, especially if the scene 
was lit by more than one type of light, or under difficult conditions.

Watch a 4:43 video on using the history brush
7. Selective Color & Hue/Saturation
Both tools can by used to correct tricky lighting and fix the color of 
images. If the scene is lit by more than kind of light – window light 
mixed with overhead lighting or sunlight and shadow for example, the 
color of part of the scene may be wrong.

Selective Color:  Image>Adjustments>Selective Color allows you to 
alter the color of one specific color. So if the yellow channel has too 
much red in it, you can remove the red without changing other colors 
that might have red in their mix.

Hue Saturation:  Image>Adjustments>Hue/Saturation allows you to 
adjust the hue, saturation and brightness of the image or individual 
color channels. Another useful tool in adjusting of fixing the color mix 
of a photo 

Watch a 4:30 video on using Selective Color and Hue/Saturation

https://vimeo.com/177012488
https://vimeo.com/177185283
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8. Captions
It is vital to caption your images. Captions make the image searchable 
on your computer and on the Internet. 

Captions give the photo context and make them more valuable. 

Photos are an historical record and the caption is part of that record.

Captions explain and give meaning to your photographs.

The caption information is part of what we call metadata. It is           
information about information. 

You can apply the caption information in Photoshop or in Lightroom 
or Photo Mechanic – Depending on what software you have available.

Once saved it is digitally stored with the photo – part of the image file.

In Photoshop, go File>File info...

The Description field 
is where you type your 
complete caption infor-
mation.

You can add information 
to the other fields includ-
ing your photo credit 
under the Origin tab.

Watch a 4:16 video on adding a caption to a photo

https://vimeo.com/177186193
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9. Save your Image Files
Part of your workflow needs to be a way to stay organized. If 
you can’t find your photos, they have no value.  They are certainly 
worthless as part of an assignment, but even worse, in the real 
world where if you can’t find a photo or lose a file you’ll be in deep 
doo doo (a technical term)

YOU SHOULD HAVE BEEN WORKING ON A COPY

If you follow good workflow, you still have an original untouched 
version of your file. This version, the toned and captioned version 
should be saved with a unique name that tells you something about 
the photo.

File names should have no spaces and no special characters.

Use only letters, numbers, hyphen and dash.

My system:

date_name_slug 
The date the photo was taken
Your name (so a teacher or client or boss immediately knows who 
took the photo)
A slug that tells what assignment the photo goes with

20160901_YourName_Circus_01

This photo, for example, was taken on September 1, 2016 by you, 
and is the first photo from the Circus assignment.

•
I use the year at the 
beginning of my file 
name because I think 
sorting by year makes 
sense for me. It puts 
all the 2016 files to-
gether. 

•
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10. Reformat your card
If possible, don’t do this until the end. Your card is your backup incase 
everything goes wrong :)

Format the card in the camera 

Use the camera to format the card, never delete files off a card from 
the computer.  You want to use the format function of the device to 
properly erase and ready the card for next time.

DON’T reformat until you are SURE you have properly saved your images

There are many many many other features and tools in Photoshop. 

There are some other ways to adjust photos that can be useful, includ-
ing:

Shadow/Highlights – you can open up shadows or add detail 
back into highlights (within limits)

Brightness/Contrast – another way to control the brightness 
and contrast of a photo

Curves – Similar to Levels but instead of three arrows you can adjust 
the image anywhere along the curve.

You can explore these tools as you gain familiarity with the program.

•
Ideally you should 
have a card        
dedicated to one 
device. 

It is better not to 
use a card in more 
than one camera.

And it is a ter-
rible idea to store      
folders of other files 
on your card.

Each device writes a 
‘table of contents’ on 
the card to keep files 
organized. Multiple 
devices means mul-
tiple tables increasing 
the odds that your 
card will fail.

•
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SHOOTING RAW

Until now, I have assumed you are shooting jpegs. This is the almost 
universal image file format that is found on almost every device and 
website.

JPEGS are small image files that can be viewed online, opened in most 
applications.  They offer compatibility and small file size.

But think about that – how can they be so small?  Why are they so 
universal?

JPEGS are small because  the files are compressed. Information is 
discarded to reduce the file size. Enough is kept so the image still looks 
good.

When you take a photo with your camera, a lot of information is 
applied to the file – the white balance you set, perhaps contrast or 
sharpness.

All of this is stored in the JPEG file and used to display the image. 

What if it wasn’t?

What if you could take the ‘raw’ unprocessed digital information and 
manipulate it after the fact in Photoshop?

Well, you can. Each camera manufacturer has it’s own formula for what 
we call a Raw file. And Photoshop can open almost all of them. 

•
When a brand new 
camera is intro-
duced it may take          
Photoshop a few 
weeks or months to 
introduce an update 
for processing the 
Raw file

•
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Nikon calls its Raw files NEFS, Canon has CR2 files, etc. 

The advantage of Raws is that you start in Photoshop with a lot more 
information and data. Nothing is compressed, no settings locked into 
the file.

The disadvantage is that the files are much larger – your camera’s card 
will hold fewer images.
Not all software can edit or see a Raw file. You’ll need to use         
Photoshop or some other image editor to convert the files to a     
universal format like a jpeg.

IF you decide to shoot in the RAW format, the image will open in a 
different window inside Photoshop.

Note the controls. You can set a white by using the eyedropper and 
clicking on something neutral.  You can fine tune your settings with the 
adjustments on the right – changing exposure, contrast, color, etc.
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You can make local adjustments by  using the Adjustment brush.

To use the brush, ‘paint’ over the area you want to adjust. You can 
change the settings before or after using the brush.  You can’t select an 
area as you would with the Lasso or Quick Selection tools, but you can 
still make many adjustments.

When you’re done, open the image, make any final corrections, add 
a caption and save it as a jpeg or other format. The original Raw file 
remains as a backup.

Watch a 6:10 video on using Camera Raw

https://vimeo.com/177167515
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Photoshop is an extremely powerful application. This tutorial only 
scratches the surface of what the app can do. 

The goal of this document is to introduce you to the program and give 
you the skills to adjust a photograph’s basic tone and color. These basic 
adjustments compensate for the limits of photography.

A photograph can’t (yet) see as well as the human eye. It can’t see the 
range of brightness or detail. 

And both the camera and the camera operator (you) are imperfect. 
Exposures may not be perfect, color and contrast may not look as 
we’d hoped or as the scene actually appeared. 

These basic Photoshop skills can help make a photo look better online 
or in print.

For those of you looking to dig deeper into Photoshop’s magical 
abilities to transform images, there are numerous online resources. 
LinkedinLearning.com (free to Penn State students) offers tutorials. You 
can find many free resources on Youtube.com and Adobe.com offers 
tutorials as well.

And you can always contact me if you have questions.

Will Yurman
will.yurman@gmail.com
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